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This document is intended to help new or existing developers quickly start evaluating the EVK and using SDK to 
develop Wi-Fi applications with the RA6W1 chipset.
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1.    Terms and Definitions
API  Application Program Interface
Arm  Advanced Risk Machine
Bluetooth LE  Bluetooth® Low Energy
COM  Communication Port
CPU  Central Processing Unit
DMP  Dynamic Power Management
EVB  Evaluation Board
EVK  Evaluation Kit
FSP  Flexible Software Package
GCC  GNU Compiler Collection
GPIO  General-Purpose Input/Output
IC  Integrated Circuit
IDE  Integrated Development Environment
MCU  Micro Controller Unit
PMGR  Power Manager
QSPI  Quad Serial Peripheral Interface
RAM  Random Access Memory
ROM  Read Only Memory
RTC  Real Time Clock
RTOS  Real Time Operating System
SD  Secure Digital
SDK  Software Development Kit
SMA  SubMiniature version A
SPI  Serial Peripheral Interface
UART  Universal Asynchronous Receiver/Transmitter
UDP  User Datagram Protocol
WLCSP  Wafer Level Chip Scale Package
WSL  Windows Subsystem for Linux

2.    Overview
RA6W1 is a highly integrated ultra-low-power Wi-Fi microcontroller unit(MCU)  that allows you to develop Wi - Fi 
solutions using a single chip. This Getting Started Guide provides an overview of setting up the RA6W1 EVK, 
Programming the released SDK images, instructions for importing and building images with the sample project 
template using e2 studio Integrated Development Environment (IDE).
The following are the quick guidelines to start using EVK:
 n RA6W1 EVK hardware (see Section 3 Evaluation Kit).
 n Setting up the evaluation board (see Section 4 Set Up RA6W1 EVK).
 n Programming firmware image (see Section 4.1 Firmware Image Programming).
 n Configuring EK- RA6W1 Serial Debug Interface image (see Section 4.2 Configure RA6W1 EVK Serial Debug 

Interface).
 n Provisioning Wi-Fi (see Section 4.3 Provision Wi-Fi).
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 n Evaluating throughput with iPerf (see Section 5.1 Test Throughput with iPerf Traffic Generator).
 n Measuring current consumption (see Section 5.2 Measure Current Consumption).
 n Software Development Kit and Build Setup (see Section 6 Software Development Kit and Build Setup).
For more resources, go to:
 n RA6W1 product page (https://www.renesas.com/en/products/ra6w1) – documentation, example projects. 
 n EK-RA6W1 board page (https://www.renesas.com/en/design-resources/boards-kits/ek-ra6w1).

https://www.renesas.com/en/products/ra6w1
https://www.renesas.com/en/design-resources/boards-kits/ek-ra6w1
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3.    Evaluation Kit
The RA6W1 EVK is designed to test and develop Wi-Fi applications quickly. The EVK is provided to simplify the 
process of starting a project with the RA6W1.
The EVK contains:
 n Evaluation kit (EVK): made by a motherboard with debugging and power measurement circuitry and a daterboard 

containing the RA6W1 chip and related needed circuitry.
 n USB cable.

3.1  RA6W1 EVK
Figure 1 shows the hardware configuration of the RA6W1 EVK and Table 1 shows EK-RA6W1 components and 
descriptions.

Figure 1. RA6W1 EVK hardware configuration
Table 1. RA6W1 EVK components
No Name Description
1 USB302 – USB port Provides power and data port for the RA6W1 EK.

2 U301 – USB HUB Connects JTAG and UART interfaces to the PC.

3 J201/J203 – 
Signal/Power breakout 
headers

Exposes all the pins of the Daughterboard and Motherboard to allow wiring for custom 
configurations as well as monitoring of the hardware signals. See Figure 2 and Figure 3.

4 U201- daughterboard 
connector

The interface mating connector for the Daughterboard.

5 J206/J207/J215/J216 - 
Arduino sockets

The sockets for plugging in Arduino interface add-on boards. See Figure 9.

6 J208/J209 - 
MikroBUS™ sockets

Sockets for plugging in MikroBUS™ interface add-on boards. It is multiplexed with PMOD (to be 
used with DA1453x). See Figure 13.
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No Name Description
7 J219 - PMOD 

connectors
The socket for plugging in PMOD interface add-on boards. J319 is a header, No mounted. J219 and 
J319 share some signals which are multiplexed with MikroBUS™. See Figure 5.

8 J607 - Push-buttons J607 push-button used to reset Daughterboard, J608/J609/J610 push buttons for general use. See 
Figure 11.

9 J2/J102 - Power 
selection

The current sense circuit option. Using this current measurement circuit, you can monitor the current 
consumption of Daughterboard through Smart Snippets Toolbox software application.

10 J105/J106/J107 - I/O 
voltage selection

Selects the I/O voltage applied to the Daughterboard (1.8 V, 3.3 V).

11 U503 - Current sense The current sense circuit.

12 J3 - SPI interface 
switch

Selects the I/O voltage generated for the Daughterboard board (1.8 V, 3.3 V). See Figure 14.

13 U302 - USB interface 
IC

Provides communication between Daughterboard UART port and PC. It also transfers the current 
measurement samples to PC.

14 U7 - Level translators Transfers the data between Daughterboard and FTDI (U302) in proper voltage level.

15 J405 - External J-link 
connector

Provides access to Wi-Fi MCU or Bluetooth LE MCU. See Figure 6.

16 U401 – MCU Place where the SWD implementation of SEGGER applied.

17 J220 - SDIO header Must be mounted.

18 J601 – Trigger The trigger signals monitored and presented on Smart Snippets Toolbox. See Figure 12.

19 U2/U6/U8/U9 - Level 
translators

For the interface section (PMOD, Android and MikroBUS).

20 J611 – LEDs Four LEDs are connected to this header. To enable an LED, a jumper wire must be connected 
between a GPIO and one of the pins of J611.

21 U202 - PSRAM PSRAM. See Figure 4.

22 J6 – AIN GND AIN is a generic Analog Input which is accessible on J6 header.

23 Daughterboard  

Figure 2. Breakout header J201
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Figure 3. Breakout header J203

Figure 4. PSRAM

Figure 5. PMOD
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Figure 6. External J-link connector

Figure 7. Auxiliary UART

Figure 8. Programming RA4M2
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Figure 9. Arduino Interface

Figure 10. Daughter_Board Connector



RA6W1 Getting Started Guide

R19US0014EK0105   Rev 1.05 Page 12
Apr 28, 2026

Figure 11. Buttons

Figure 12. Trigger

Figure 13. Micro BUS
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Figure 14. J3
Figure 15 shows the hardware configuration of the daughterboard of RA6W1 EVK.
NOTE
Renesas recommends using a daughterboard with antenna.

Figure 15. RA6W1 daughterboard
Table 2 shows the components of EK-RA6W1 daughterboard.
Table 2. RA6W1 EVK daughterboard components
No Name Description
1 U101 – RA6W1 RA6W1 – WLCSP

2 U102 – Serial flash Serial flash – AT25SL641

3 Y101 – Crystal 40 MHz crystal

4 Y102 – Crystal 32.768 kHz crystal

5 U202 – J-flash connector J-link for SPI flash connector

6 J101 – SMA connector SMA connector for external antenna

7 J201 – Reset switch Switches to reset the RA6W1
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4.    Set Up RA6W1 EVK
Before setting up ensure that the Evaluation Kit (EVK) and the required software are properly connected and installed. 
Use the USB cable included in the EVK to connect the host computer and the EVK. When the EVK is connected to the 
USB port (USB302 on the RA6W1 EVK) USB Serial COM ports are created.
 n For Windows, three USB Serial COM ports are displayed in the device manager (see Figure 16).

Figure 16. Windows – COM ports
NOTE
If Windows Device Manager displays Unknown Device, the FTDI serial driver is not installed. Download the driver by following 
the URL and installing it manually: http://www.ftdichip.com/Drivers/.

The lower numbered J-Link CDC UART Port (COM7, in this case) is the onboard J-Link. The next USB Serial Port 
(COM8, in this case) is for the RA6W1 debug interface. The higher numbered USB Serial Port (COM9, in this case) is 
for the RA6W1 AT command interface or current consumption measurement. A serial terminal application can be used 
for debugging RA6W1.
The Tera Term terminal emulator program is recommended and can be downloaded from 
https://github.com/TeraTermProject/teraterm/releases/tag/v5.2.
 n For Linux, two Serial COM ports are created. It can be checked using the following command in Terminal.

developer:~$ ls /dev/ttyUSB*
developer:~$ /dev/ttyUSB0 /dev/ttyUSB1

The lower numbered USB Serial Port (/dev/ttyUSB0, in this case) is for the RA6W1 debug interface. The higher 
numbered USB Serial Port (/dev/ttyUSB1, in this case) is for the RA6W1 AT command interface or current 
consumption measurement. A serial terminal application can be used for debugging RA6W1.
Minicom is recommended for Linux and to install minicom on Linux, run this command:

developer:~$ sudo apt-get install minicom

When the terminal emulation application is installed, connect the USB cable to USB302 on the RA6W1 EVK and start 
the terminal emulation program. In the terminal emulation program, go to the Serial Port setup and select the preferred 
COM Port.

4.1  Firmware Image Programming
4.1.1    Program Firmware Images for Windows
Programming firmware images to the EVK requires the Renesas Flash Programmer (RFP) tool. The RFP provides a 
graphical interface to flash binary images into the RA6W1 EVK through the on-chip debug interface.
System requirements:
 n OS: Windows 11 (64 bit)
 n USB drivers (installed along with RFP setup)
 n Renesas Flash Programmer V3.22.00 or later
 n Hardware: RA6W1 EVK.

http://www.ftdichip.com/Drivers/
https://github.com/TeraTermProject/teraterm/releases/tag/v5.2


RA6W1 Getting Started Guide

R19US0014EK0105   Rev 1.05 Page 15
Apr 28, 2026

To program firmware:
 1. Download and launch the Renesas Flash Programmer installer.
 2. In the Software License Agreement dialog, select Agree, then click Next.
 3. During installation, in the Windows Security dialog, to install the Renesas USB driver, select Always trust 

software from ″Renesas Solutions Corp.″, and click Install, and then click Next.

Figure 17. Windows Security prompt for USB driver installation
 4. After installation is completed, to exit the setup, click Finish.
 5. From the Windows Start menu, launch the Renesas Flash Programmer tool.
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Figure 18. RFP GUI
 6. Connect the RA6W1 EVK to the PC using the USB debug interface.

Figure 19. RA6W1 EVK hardware
 7. In the tool, to create a new project, go to File > New Project, and do the following:
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 a. In Microcontroller, select the RA6W1, RA6W2 as the target microcontroller.

Figure 20. Selecting target microcontroller
 b. In Project Name, enter a project name and click Connect.
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Figure 21. Connecting RA6W1, RA6W2 EVK
After the device is connected, the status message displays Operation completed.
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Figure 22. Connection status – operation completed
 8. In the File Details dialog, to confirm the file selection, click OK.



RA6W1 Getting Started Guide

R19US0014EK0105   Rev 1.05 Page 20
Apr 28, 2026

Figure 23. Confirming file selection
 9. In Renesas Flash Programmer, to flash the image, click Start.
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Figure 24. Start programming
The Progress Report dialog appears, showing the running progress.
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Figure 25. Progress report
When the programming is completed, the status window displays ″Operation completed″, indicating that the 
firmware image is successfully written to the RA6W1 EVK.
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Figure 26. Programming completed successfully

4.1.2    Program Firmware Images for Linux
Programming firmware images to EVK in Linux requires the CLI tool of Renesas Flash Downloader.
System requirements:
 n OS: Ubuntu 22.04.4 LTS or later.
 n J-Link Linux driver – J-Link Version 864 or later.
 n Renesas Flash Programmer V3.22.00 or later
 n Hardware: RA6W1 EVK.
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To program the firmware:
 1. Extract the RFP_CLI_Linux_V32200_x64.tgz.

tar -xzf RFP_CLI_Linux_V32200_x64.tgz

 2. Go to the extracted folder and check the J-Link serial number.

cd linux-x64/
./rfp-cli -d RA6W1 -lt

 3. Program the firmware.

./rfp-cli -d RA6W1 -tool jlink:<jlink_serial_no> -if swd -s 25M -auto -bin 0 <path_to_.img 
file>

For example of successful operation, see Figure 27.

Figure 27. Programming of firmware in Linux

4.1.3    Program Firmware Images for macOS
Programming firmware images to EVK in macOS requires the CLI tool of Renesas Flash Downloader.
System requirements:
 n OS: Mac OS 14 (Sonoma) or later versions.
 n J-Link driver – J-Link Version 864 or later.
 n Renesas Flash Programmer V3.22.00 or later
 n Hardware: RA6W1 EVK.
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To program firmware:
 1. Extract the RFP_CLI_macOS_V32200_arm64.zip.

tar -xzf RFP_CLI_macOS_V32200_arm64.zip

 2. Go to the extracted folder and check the J-Link serial number.

cd macos-arm64
./rfp-cli -d RA6W1 -lt

 3. Program the firmware using this command:

./rfp-cli -d RA6W1 -tool jlink:<jlink_serial_number> -if swd -s 25M -auto -bin 0 <path_to_.img 
file>

For example of successful operation, see Figure 28.

Figure 28. Programming of firmware in macOS

4.2  Configure RA6W1 EVK Serial Debug Interface
The RA6W1 provides a command/debug interface on UART0 for performing configuration and diagnostic functions. 
Connect the USB cable to the USB debug interface on the RA6W1 EVK and start the terminal emulation program.

4.2.1    Configure Tera Term Serial Terminal Application for Windows
 1. In the Tera Term program, go to the Serial Port setup and select the lower numbered COM port (COM8, in this 

case) and configure it as in Table 3 and Table 4.
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Figure 29. Serial port setup
 2. Connect USB cable to RA6W1 EVK and pressing Enter. The following prompt appears in the UART console:

[/RA6W1-RRQ61001]
Table 3. Serial port configuration values

Settings Value
Baud Rate 115200

Data Bits 8

Parity None

Stop Bits 1

Flow Control (Hardware/Software) None

Table 4. Terminal settings
Settings Value
Receive LF

Transmit CR + LF

4.2.2    Configure Minicom for Linux
 1. Connect the USB cable to the USB Debug Interface on the RA6W1 EVK and open a terminal for the minicom.
 2. Start minicom using the following command:

developer:~$ sudo minicom -D /dev/ttyUSB0

 3. Enter the password. 
After entering the password, minicom terminal view opens, see Figure 30.
NOTE
/dev/ttyUSB0 is for the debug interface and /dev/ttyUSB1 is for the AT command interface

Figure 30.  Minicom terminal view
 4. To configure minicom, press Ctrl+A followed by Z. It prompts a command summary as shown in Figure 31.
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Figure 31. Minicom command summary
 5. When prompt appears, type O to select O for "cOnfigure Minicom..O".
 6. In the configuration prompt, select Serial port setup.
 7. Configure minicom values using letters as shown in Table 3 using letters to configure. For example, to select Baud 

rate, use E.

Figure 32. Setting minicom values
 8. After it is configured, use Save setup as dfl for saving as default.
 9. Press Enter. 

The Configuration saved dialog appears.

Figure 33. Configuration saved
 10. Click Exit.
 11. For proper minicom printing, press Ctrl+A followed by Z. It prompts the command summary in Figure 34.
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Figure 34. Minicom command summary window
 12. Select U for Add Carriage Ret..U.
 13. To complete the configuration, press Enter. See Figure 35.

Figure 35. Successful configuration
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4.2.3    Configure RA6W1 EVK AT Command Interface
4.2.3.1    AT Command Jumper Configuration

For using ATCommands, flash wifi_test_at_uart_ek_ra6w1_ep.img.
The following jumper connections are necessary to facilitate the AT command UART connection, see Figure 36:

Figure 36. Jumper connections

4.2.3.2    AT Command Terminal Configuration

The RA6W1 provides an AT command interface on UART1 for performing configuration. Connect the USB cable to the 
USB302 on the RA6W1 EVK and start the terminal emulation program. In the terminal emulation program, go to the 
Serial Port setup and select the higher numbered COM port (COM9, in this case) and configure it as in Table 3  and  
Table 4.
For more AT command details, see AT Command Manual. For basic connection using AT commands, see 1 AT 
Command Wi-Fi Provisioning.
When connecting USB cable to EK-RA6W1, the screen is initially blank. Enter the following command (which is hidden 
by default) in the blank screen to enable echo output:

ATE //(hidden)
Echo on //(command return)
OK

4.3  Provision Wi-Fi
Provisioning a Wi-Fi device is the process of setting up the device to connect to a network and function properly. This 
involves configuring network settings, ensuring secure authentication, and assigning necessary parameters.

After the terminal emulator setup ( Section 4.2 ) , Please follow the below steps.

4.3.1    Factory Reset (Optional)
Factory reset reverts the board to default configurations. To reset the board to default settings, enter: factory in the 
UART console window through Tera Term (or your console emulator).

../../../../../../../../../Content/RA6W1 Getting Started Guide/Appendix B AT Command Wi Fi Provisioning.htm
../../../../../../../../../Content/RA6W1 Getting Started Guide/Appendix B AT Command Wi Fi Provisioning.htm
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After Factory Reset, the RA6W1 reboots. The Easy Setup Wi-Fi configuration wizard appears automatically.

4.3.2    Setup for Station Mode
You can configure the Wi-Fi functions of the RA6W1 by running the Easy Setup Wi-Fi configuration wizard.
NOTE
In case of factory reset, the Easy Setup Wi-Fi configuration wizard appears and then follows the following prompts. If 
reconfiguring, complete the following step.

To configure the RA6W1 for operating in Station mode, open its debug console and run the setup command at the 
[/RA6W1-RRQ61001] prompt. To complete the setup, follow the following prompts:

[/RA6W1-RRQ61001] # setup                        //Start the Easy Setup Wizard.
 
Stop all services for the setting.
Are you sure ? [Yes/No] : Y                        //Enter Y to stop the services.
 
[RA6W1-RRQ61001 EASY SETUP - V4]
 
Country Code List:
AD  AE  AF  AI  AL  AM  AN  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH
BL  BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY
CZ  DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF
GH  GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM
JO  JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC
MD  ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO
NP  NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU
RW  SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA
UG  UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ZZ
 
COUNTRY CODE ? [Quit] (Default KR, ZZ : for debug) : KR          // Enter the country code.
 
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
MODE ?  [1/2/3/4/5/Quit] (Default Station) : 1                      // Enter 1 for Station mode.
 
BAND ?
        1. 2.4 GHz
        2. 5 GHz
        3. AUTO
BAND ?  [1/2/3/Quit] (Default 3. AUTO) : 1                  // Choose WiFi Frequency Band.
 
[ STATION CONFIGURATION ]
============================================================
[NO] [SSID]                         [SIGNAL] [CH] [SECURITY]
------------------------------------------------------------
[ 0] ASUS_TPT_24G                       -48   1         WPA2
[ 1] ASUS_KEYSGT_24G                    -50  11         WPA2
[ 2] SK_WiFiGIG_24G                     -54   6         WPA3
[ 3] ASUS_JIT_EAP_24G                   -56  6 WPA + WPA2 ENT
[ 4] DIRECT-GM2020                      -66  11  WPA2 + WPA3
[ 5] olleh_WiFi_B602                    -67   6         WPA2
[ 6] KT_GiGA_2G_Wave2_04A               -70   6         WPA2
[ 7] Vantest24g                         -79   6         OPEN
[ 8] [Hidden]                           -81   6         WPA2
------------------------------------------------------------
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[Enter] Rescan
============================================================
 
Select SSID ? (0~8/Manual/Quit) : 0                    // Enter the SSID NO from the list.
 
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
**********                                // Enter the password for the AP.
 
Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : N                                                                                                        
                                                                     // Enter N to skip this step.
Enable DPM (Dynamic Power Management) ? [Yes/No/Manual/Quit] : N
 
============================================
BAND        : 2.4 GHz
SSID        : ASUS_TPT_24G
Security    : WPA2PSK
ENCRYPTION  : AES(CCMP)
Password    : **********
PMF         : Default
============================================
WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y                     // Enter Y to confirm the 
configuration.
 
 
IP Connection Type ? [Automatic IP/Static IP/Quit] : A            // Enter A for automatic DHCP IP 
address.
 
 
IP Connection Type: Automatic IP
IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y                        // Enter Y to confirm the 
configuration.
 
 
SNTP Client enable ? [Yes/No/Quit] : N                            // Enter N to disable time sync.
 
 
[/RA6W1-RRQ61001] #
Connection COMPLETE to cc:28:aa:7f:02:48
 
>>> Network Interface (wlan0) : UP
         Assigned addr   : 192.168.50.130
               netmask   : 255.255.255.0
               gateway   : 192.168.50.1
         DHCP Server IP  : 192.168.50.1
         Lease Time      : 24h 00m 00s
         Renewal Time    : 12h 00m 00s
 

The configuration is now completed and stored in NVRAM. For configuring different Wi-Fi modes, see Appendix 1 
Configuration Modes Setup .

../../../../../../../Content/RA6W1 Getting Started Guide/Appendix A Configuration Modes Setup.htm
../../../../../../../Content/RA6W1 Getting Started Guide/Appendix A Configuration Modes Setup.htm
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5.    Test Procedures
The following sections describe several tests that verify the proper operation of the RA6W1 and demonstrates its 
various features.
The tests include:
 n Throughput Test – demonstrates the Wi-Fi performance of the RA6W1.
 n Current Consumption Measurements – demonstrates the amount of power used when the RA6W1 is in various 

Sleep modes or in Operational DPM mode.

5.1  Test Throughput with iPerf Traffic Generator
iPerf is a free IP-based a traffic generator tool that can be used for active measurements of the maximum achievable 
bandwidth on IP networks.
iPerf 2.1.3 (recommended) for Windows and Linux can be downloaded from 
https://sourceforge.net/projects/iperf2/files/.
There are various test setup types that can be used for Wi-Fi throughput tests:
 n Conducted – uses RF cables to connect the communicating devices. This effectively eliminates issues caused by 

the wireless domain.
 n Wireless/Over the Air – uses antennas connected to the station and access point, as opposed to RF cables, thus 

introducing additional elements and better replicating real-life usage.
 n Hybrid (Wireless plus Attenuation Control) – is the same as a wireless test setup, using antennas, but digital 

attenuators are also introduced as part of the signal path between the AP’s RF ports and antennas. This allows for 
total control over the RSSI, replicating varying distance between the Access Point and Station.

The provided examples work in any of the above scenarios.
NOTE
For clean and accurate results, Renesas recommends using an anechoic RF chamber for any of the mentioned tests.
Also use a dedicated Access Point for tests. If iPerf does not work and the issue is related to firewall restrictions, contact IT 
department.

5.1.1    Configure Testbed
To configure the Testbed:
 1. Download iPerf 2.1.3 from https://sourceforge.net/projects/iperf2/files/.
 2. Create a folder called "iperf" in the C:\ directory.
 3. Unzip the downloaded iPerf file (if necessary) and move the contents to the "iperf" folder.
 4. Rename the downloaded iperf executable file from "iperf-2.1.3-win.exe" to "iperf.exe".
 5. To ensure stable iPerf testing, run the Windows Security APP and turn off the network firewall. It is recommended 

to disable the laptop from all network firewalls before attempting a test.
To set up the Test Environment after setting up the iPerf:
 1. Connect your computer to the LAN port of an Access Point (such as the Asus RT-AX88U) through an ethernet 

cable.
The computer should receive an automatic IP address from the Access Points DHCP server. If the Access Point is 
configured to not provide automatic IP addresses, make sure to manually configure your computer to use a 
suitable IP address and subnet mask. Make sure that the computer is not connected to any other networks over 
ethernet or Wi-Fi.

 2. Connect EK-RA6W1 EVK wirelessly to the same Access Point SSID (for instructions on how to configure the Wi-Fi 
connection for the RA6W1, see Section 4.3.2 Setup for Station Mode.

 3. To verify a properly configured connection, ping the RA6W1 from your computer or ping it from the RA6W1 to your 
computer.

https://sourceforge.net/projects/iperf2/files/
https://sourceforge.net/projects/iperf2/files/
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net
ping <destination IP address>

5.1.2    Configure RA6W1 EVK as iPerf Client
The provided UDP uplink iPerf example can be used to primarily evaluate TX throughput speeds.

Figure 37. UDP uplink iPerf example
To configure as iPerf server for Windows:
 1. Start an iPerf Server on your laptop by opening the command prompt and navigating to the directory in which iPerf 

is located.
 2. Type "ipconfig" in the command prompt to see your laptop’s IP address.

Figure 38. IP address
 3. Start the UDP server in the Windows command prompt.

iperf.exe –s -i1 -u

Figure 39. Start UDP
To run traffic from the RA6W1 EVK to the iPerf server on the Windows computer:
 1. Select the network Command mode, in the Tera Term console, by typing the net command.
 2. Start the UDP client:
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iperf -I WLAN0 -c <Server IP> -t 10 -i 1 -u

 3. Read the throughput measurements from the iPerf server window.

Figure 40. Measurements

5.1.3    Configure RA6W1 EVK as iPerf Server
The provided UDP downlink iPerf example can be used to primarily evaluate RX throughput speeds.

Figure 41. UDP downlink iPerf example
To configure RA6W1 EVK as iPerf Server:
 1. Select the network command mode, by typing the net command in the Tera Term console.
 2. Start the UDP server:

iperf -I WLAN0 -s -u -i 1
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Figure 42. Start UDP
 3. Close the existing command prompt on the laptop running the UDP server.
 4. Open the command prompt and navigate to the directory where iPerf is located.
 5. Start the UDP client in the Windows command prompt:

iperf.exe -c <Server IP> -t 10 -i 1 -u -b100m

Figure 43. Start UDP client

5.2  Measure Current Consumption
NOTE
Current consumption measurement through Smart snippet is possible with the latest Evaluation Kit.

There are numerous available methods to measure current consumption to evaluate the power save performance of 
different sleep and DPM configurations.
The following instructions explain how to perform such measurements using the SmartSnippets Toolbox (Section 
5.2.2 Measure with SmartSnippets) or a standard power analyzer (Section 5.2.3 Measure with Power Analyzer) and 
focus measuring current consumption in forced Sleep modes and DPM mode.

5.2.1    PMGR Sleep Mode CLI Commands
RA6W1 can be configured to temporarily enter Power Manager (PMGR) Sleep modes 2 to Sleep mode 3 for a 5 
second duration through CLI commands (custom durations are not yet supported):

[/RA6W1-RRQ61001/pmgr] # pmgr force
- Usage: force [lld_states: PMGR_LLD_POWER_MODE_SLEEP2, PMGR_LLD_POWER_MODE_SLEEP3, PMGR_LLD_POWER_
MODE_SLEEP4, PMGR_LLD_POWER_MODE_DPM,    PMGR_LLD_POWER_MODE_CPU_WFI, PMGR_LLD_POWER_MODE_AUTO]
[/RA6W1-RRQ61001/pmgr] #

Example:

pmgr force PMGR_LLD_POWER_MODE_SLEEP3

To prepare SmartSnippets Toolbox:
 1. Download and install the latest version of the SmartSnippets Toolbox for current measurement from the Renesas 

Product webpage or from the provided evaluation Software package.



RA6W1 Getting Started Guide

R19US0014EK0105   Rev 1.05 Page 36
Apr 28, 2026

Figure 44. SmartSnippets toolbox
 2. Connect jumpers between the pins highlighted in red in Figure 45. LED light turns on when jumper J102 is set.

Figure 45. Jumper setting
 3. Connect the EVK to your computer through USB.
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5.2.2    Measure with SmartSnippets
To measure the current consumption with SmartSnippets:
 1. Disassemble the RA6W1 daughterboard from the motherboard and power up the EVK through USB to your 

computer.
 2. Close any open instances of the UART COM port.
 3. Open SmartSnippets Toolbox on your computer.
 4. Select Board > Device > RA6W1.

Figure 46. RA6W1
 5. On the Chart View tab, select VBAT_WI-FI and CH1/CH2 Charge checkboxes.

Figure 47. Chart View tab
You should see the VBAT Wi-Fi – CH1/CH2 current measurement window.

 6. Identify the RA6W1 EVK -related COM ports through the Windows Device Manager.
 7. Based on the identified pair of COM ports belonging to the RA6W1 EVK (in this case COM21 and COM22), select 

the following configurations:
 a. Select Board > PowerProfiler > (Higher-numbered COM port).

Figure 48. Power profiler port
 b. Select OffsetCalibration > CH1/CH2 in SmartSnippets.
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Figure 49. Offset calibration
NOTE
Offset calibration is required to find the current consumption values of motherboard before inserting daughterboard. This 
way the measurement of daughterboard is accurate. Calibration takes 10 seconds, and the values are saved in the 
configuration.

 8. Connect the RA6W1 EVK daughterboard to the motherboard.

Figure 50. EVK daughterboard to the motherboard connection
 9. Press down the RST_N (Reset) button on the RA6W1. If the board has previous connection to an AP, it 

automatically re-connects.

Figure 51. Reset button
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 10. In SmartSnippets, select Start.
 11. Connect to the console through UART using Tera Term, see Section 4.2 Configure RA6W1 EVK Serial Debug 

Interface.
 12. In the UART console, select the needed configuration:

Example:
Configure the RA6W1 as in Station + DPM mode (see Appendix A.2 Set up EVK for Station plus Soft AP Mode).
//OR//
Enter forced sleep modes (2 or 3) by using the following command syntax: "pmgr force <mode>"
pmgr force PMGR_LLD_POWER_MODE_SLEEP3

 13. In SmartSnippets, select Stop.
 14. To measure the average current consumption over a selected period, on the Tools tab, click Measure.
 15. Click and drag the measurement cursor over the section that you want measure in the top screen (CH1/CH2 

Current – VBAT) and read the "Iav" measurement for the average current between the selected measurement 
points.

Figure 52. Measurement points

5.2.3    Measure with Power Analyzer
To measure the current consumption with Power Analyzer:
 1. On the Power Analyzer, select the current measurement mode.
 2. Connect jumpers between the pins and connect the current measurement points to the power analyzer, see Figure 

53.
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Figure 53. Jumper connections between pins
 3. Assemble the daughterboard to the motherboard and turn on the EVK by connecting it to your computer through 

USB C.
 4. Connect to the console through UART using Tera Term, see Section 4.2 Configure RA6W1 EVK Serial Debug 

Interface.
 5. In the UART console, select the needed configuration:

Example:
Configure the RA6W1 as in Station + DPM mode (see Appendix A.3 Set up Station Mode with DPM Enabled).
//OR//
Enter forced Sleep modes (2 or 3) by using the following command syntax: "pmgr force <mode>"
pmgr force PMGR_LLD_POWER_MODE_SLEEP 2 

 6. Perform measurements with the power analyzer:
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Figure 54. Measurements
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5.2.4    Measure Sleep 1 Current Consumption
To measure the current consumption for Sleep 1 follow the same process as in Section 4.3.2 Setup for Station Mode 
and Appendix A.1 Set up Soft AP Mode, you do not need any configuration in the CLI.
The following modifications are needed in the test setup to force the device to Sleep 1 Mode:
 1. Remove the pull-up on the RST of the daughterboard.

Figure 55. Remove resistor
 2. Remove the J210 jumper on the motherboard.
 3. Connecting a jumper between the GND and J210 RST_N pins.

Figure 56. Connecting jumper between pins
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6.    Software Development Kit and Build Setup
Wi-Fi applications can be developed for the RA6W1 using the RA6W1 FreeRTOS Software Development Kit (SDK) 
and the Renesas e2 studio IDE on either a Windows 10, Linux or macOS based development system.
To start developing applications for the RA6W1, complete the following steps:
 1. Install and configure the e2 studio IDE.

 2. Import the RA6W1 SDK into the e2 studio IDE and build an application.

 3. Download and test the application.
 4. Use J-Link debugger to debug the application.
Figure 57 shows the typical e2 studio project for the RA6W1 FSP.

Figure 57. Project view
System requirements:
 n Windows 10 64 bit or later versions
 n Ubuntu 22.04 LTS or later versions
 n macOS 14 (Sonoma) or later versions
 n e2 studio installer-2025-12 or later versions.

6.1  Install e2 studio IDE for Windows
The following files are required for installation in Windows and can be found in the Software and Tools section of 
RA6W1 product page:
 n e2 studio installer – e2studio_installer-2025-12_windows_host.exe.
 n RA6W1 FSP pack – RAFW_FSP_Packs_2.0.1.
 n Sample project template – wifi_test_ek_ra6w1_ep.zip.
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To install e2 studio IDE for Windows:
 1. Run the installer, in the e2studio setup wizard, select Standard Install, and then select Next.

Figure 58. Standard installation
 2. On the Device Families step, select RA for Wireless.
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Figure 59. Device families
 3. On the Additional Software step, expand GCC Toolchains and Utilities, select the GNU ARM Embedded 13.3 

checkbox, and click Next.

Figure 60. Additional software
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 4. On the Licenses step, accept the terms of the software agreement by selecting the checkbox, and click Next.
 5. On the Shortcuts step, click Next.

Figure 61. Shortcuts
 6. On the Summary step, click Install.
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Figure 62. Ready to install
 7. While installing e2 studio, GNU Arm® Embedded 13.3 toolchain installation initializes.

Figure 63. Toolchain installation
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 8. Complete the toolchain installation.

Figure 64. Toolchain setup wizard
 9. When the e2 studio is installed, select the Launch e2 studio checkbox and click OK.

 10. Open e2 studio and continue with installing the RA6W1 FSP pack.

See Section 6.4 Install RA6W1 FSP Pack.

6.2  Install e2 studio IDE for Linux
The following files are required for installation in Linux and can be found in the Software and Tools section of RA6W1 
product page:
 n e2 studio installer – e2studio_installer-2025-12_linux_host.run.
 n RA6W1 FSP pack – RAFW_FSP_Packs_2.0.1.
 n Sample project template – wifi_test_ek_ra6w1_ep.zip.
To install e2 studio IDE for Linux:
 1. Give the execution permissions to the e2 studio installer and run installer, see Figure 65.

Figure 65. Installer
 2. In the e2studio setup wizard, select Standard Install, and select Next.
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Figure 66. Standard installation
 3. On the Device Families step, select RA for Wireless.
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Figure 67. Device families
 4. On the Additional Software step, expand GCC Toolchains and Utilities, select the GNU ARM Embedded 13.3 

checkbox, click Next > Install, see Figure 68.

Figure 68. Device families
 5. After completing e2 studio installation, open e2 studio and continue with installing the RA6W1 FSP pack.

See Section 6.4 Install RA6W1 FSP Pack).
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Figure 69. e2 studio

6.3  Install e2 studio IDE for macOS
The following files are required for installation in macOS and can be found in the Software and Tools section of 
RA6W1 product page:
 n e2 studio installer – e2studio_installer-2025-12_macosx_host.txz.
 n RA6W1 FSP pack – RAFW_FSP_Packs_2.0.1.
 n Sample project template – wifi_test_ek_ra6w1_ep.zip.
 n Toolchain Installer – arm-gnu-toolchain-13.3.rel1-darwin-arm64-arm-none-eabi.pkg.
 n Python 3 Installer – python-3.13.6-macos11.pkg.
To install e2 studio IDE for macOS:
 1. In the downloaded archive, extract the E2studio.app file and move it to the application folder.
 2. In the application folder, double-click E2studio.app to start the e2 studio.

If the ["E2studio.ap" is damaged and can’t be opened. You should move it to the 
Trash.] error message appears when the e2 studio is started, open the terminal window and run the following 
command:

xattr -d com.apple.quarantine /Applications/E2studio.app
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Figure 70. Error in Starting the e² studio
 3. Install the Toolchain by double-clicking the installer.

Figure 71. Toolchain Installer
 4. After Toolchain Installation is successfully completed, in e2 studio, go to Help > Add Renesas Toolchains.
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Figure 72. Add Renesas Toolchains
 5. In the Renesas Toolchain Management dialog, click Add.

Figure 73. Renesas Toolchain Management
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 6. In the Add New Toolchain dialog, click Browse.
 7. Go to Applications > ArmGNUToolchain > 13.3.rel1>arm-none-eabi, and click Open.

Figure 74. Choose the Installed Toolchain
 8. In the Add New Toolchain dialog, click OK.
 9. In the Renesas Toolchain Management dialog, click Apply and Close.
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Figure 75. Finalize Toolchain Settings
 10. Install Python3 by double-clicking Installer – python-3.13.6-macos11.pkg.

Figure 76. Python3 Installer
 11. After Python3 installation is completed successfully, restart e2 studio using File >Restart.

6.4  Install RA6W1 FSP Pack
To build the SDK, install the RA6W1 FSP pack:
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NOTE
The same procedure applies to both Windows OS, Linux and macOS.

To install the latest RA6W1 FSP Release package:
 1. Unzip the RAFW_FSP_Packs_2.0.1.zip to the e2 studio install directory.
 2. To find the exact e2 studio install directory, click Help > About e2 studio. For macOS, click e2studio > About 

e2studio.
 3. In the About e2studio dialog, click Installation Details.

Figure 77. e2 studio details

 4. In the e2 studio Installation Details dialog, select the Support Folders tab.
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Figure 78. e2 studio installation details

 5. To open the system file manager in the directory that corresponds to e2 studio install directory, click the e2 studio 
support area link.

Figure 79. Support folders
 6. Extract the RAFW_FSP_Packs_2.0.1.zip file.
 7. Copy and paste the Internal folder to the e2 studio support folder.

In MacOS, select the Merge option when copying the internal folder.
 8. To restart e2 studio, click File > Restart.
NOTE
For updating/re-installing the RA6W1_FSP_Packs, delete the following folders in the e2 studio support folder first.

 n DebugComp\rrq\
 n internal\cmsis\data\rrq\
 n internal\devassist\rafw_fsp\
 n internal\projectgen\rafw_fsp\.
Then follow Step 5 and Step 8.
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To see the module information in e2 studio, you need to integrate FSP API documentation into e2 studio. Do the 
following:
Note
This section becomes obsolete when  Platform installer for RAFW is released.

 1. On the RA6W1 product page, go to the Softwares & Tools section and download Renesas RAFW FSP 
<version> User Manual. 

 2. Unzip and rename the folder to fsp_documentation.
 3. Copy the renamed folder to e2 studio support area.

For details on opening e2 studio support area, see step 2-5 of istalation procedure for RA6W1 FSP Release 
package (Section 6.4 Install RA6W1 FSP Pack).  

 4. Restart e2 studio.
Now module information can be viewed by clicking the module resource page icon ( ).

Figure 80. Visit Module resource page button

Figure 81. Module resource page
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6.5  Load Project Template in e2 studio
wifi_test_ek_ra6w1_ep.zip is a project template to create the default Wi-Fi image of the released version.
To load the project template:
 1. Extract the wifi_test_ek_ra6w1_ep.zip project template to a directory.
 2. To import project template, click File > Import.
 3. Under General, select Rename & Import Existing C/C++ Project into Workspace.

Figure 82. Rename and import
 4. Go to the project template directory (unzip wifi_test_ek_ra6w1_ep.zip), and in the Project name field, enter the 

name and click Finish.
 5. In the Project name field, enter the name and click Finish, see Figure 83.
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Figure 83. Finish import
 6. After import finishes, install python using the following steps in Windows:

 a. Right-click the project, click Show in Local Terminal > Terminal.
 b. In console, enter "python3".

NOTE
For Windows, if Python 3 is installed already and above terminal appears, for python Integration, see Appendix D Python 
Integration in e2 studio Windows.

 c. Microsoft store appears and to install Python 3, click Get.
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Figure 84. Install Python 3
 7. Go to configuration.xml and click Generate Project Content.

Figure 85. Configuration and generate project contents
 8. To build the project, right-click the project and click Build Project.
 9. To see the build progress, open the console window.
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Figure 86. Console window
Figure 87 shows the successful build.

Figure 87. Successful build
 10. If there is no .img.bin file generated on Windows and Python 3 command does not show any error in console, 

follow the step 6.
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Figure 88. Image in Project Explorer tab
 11. To program the firmware images, see Section 4.1 Firmware Image Programming .

6.6  Flash and Debug using e2 studio
You can flash and debug in e2 studio using J-Link.
System Requirements:
 n e2 studio installer-2025-12 or later versions
 n Segger J-Link V878 or later.
To flash and debug in e2 studio:
 1. Install RA6W1 FSP Pack and Load Project Template in e2 studio.
 2. Build Debug for RA6W1.
 3. Go to Debug > Debug New_configuration.

Figure 89. Debug Configuration in e2 studio
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 4. In Debug Configurations, select Renesas GDB Hardware Debugging, and then select Launch 
Configuration.

Figure 90. Debug Configuration page
 5. On the Debugger tab, set up the target device as follows:

Figure 91. Device selection in Debugger
 6. On the Startup tab, and change load type of Program Binary to Symbols Only.
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Figure 92. Symbols only
 7. To add Download Module (.img.bin) from Debug, go to Add > Workspace > Project File > Debug > test_files 

> .img.bin.

Figure 93. Add Download Module 
 8. Change Load Type of .img.bin into Raw Binary and Offset as a000000. Then click Apply > Debug.

Figure 94. Change Load type and Offset
 9. Click Switch.
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Figure 95. Confirm Perspective Switch and Segger J-Link
 10. On Debug page, click Play.

Figure 96. Debug Page
 11. By putting a breakpoint in a file you can debug normally using debug interface. Go to C/C++ > Choose a breakpoint 

> Debug > Resume button.
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Figure 97. Debug by setting breakpoint
For more details about debugging in e2 studio, see JTAG Manual.
After flashing successfully, for test procedures, see Section 5 Test Procedures.
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7.    Example Projects
Renesas provides several example projects that demonstrate different capabilities of the RAFW MCUs. These 
example projects can be a good starting point for you to develop custom applications.
Example projects (source code and project files) for RA6W1 are available in the RAFW FSP Examples GitHub. The 
link to GitHub is available on the Software and Tools section of RA6W1 web page 
(https://www.renesas.com/en/products/ra6w1):
 n Download and extract the example projects bundle (xxxxxxxxxxxxxxxx-ek-ra6w1-exampleprojects.zip) to a 

local directory on the host PC.
 n Go to the desired example project (for example: adc_ek_ra6w1_ep) in the example projects bundle 

(xxxxxxxxxxxxxxxx-ek-ra6w1-exampleprojects\ek_ra6w1-exampleprojects\example_projects\ek_
ra6w1\adc_ek_ra6w1_ep).

 n For help on using example projects, see readme file with project.
 n The archived versions of the source code of the example projects are available in the example project repository.

https://www.renesas.com/en/products/ra6w1
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Appendix A Configuration Modes Setup

A.1 Set up Soft AP Mode
Soft AP mode allows you to provision the RA6W1 through the Wi-Fi interface using a mobile application and configure 
it by running the Easy Setup Wi-Fi configuration wizard.
To configure the RA6W1 for operating in Soft AP mode:
 1. Open the RA6W1 debug console and run the setup command in the [/RA6W1-RRQ61001] #] prompt.
 2. To complete the setup, complete the following prompts:

[/RA6W1-RRQ61001] #setup                        // Start the Easy Setup Wizard.
 
Stop all services for the setting.
 Are you sure ? [Yes/No] : Y                    // Enter Y to stop the running services.
 
[RA6W1 -RRQ61001 EASY SETUP - V4]
 
Country Code List:
AD  AE  AF  AI  AL  AM  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  BL
BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  CZ
DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  GH
GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  JO
JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  MD
ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  NP
NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  RW
SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  UG
UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ALL
 
 COUNTRY CODE ? [Quit] (Default KR) : US            // Enter the country code.
 
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
 MODE ?  [1/2/3/4/5/Quit] (Default Station) : 2        // Enter 2 for Soft-AP mode.
BAND ?
        1. 2.4 GHz
        2. 5 GHz
 MODE ?  [1/2/Quit] (Default 1. 2.4 GHz) : 1                  // Enter 1 for 2.4 Band.
[ SOFT-AP CONFIGURATION ]
 
 SSID ? (Default RA6W1-RRQ61001_B0A977) : TEST_AP             // Enter the SSID name.
 
 CHANNEL ? [1~11, Auto:0/Quit] (Default Auto) :        // Enter to select Auto channel selection.
 
AUTHENTICATION ?
         1. OPEN                                        // No authentication or encryption; any 
device can connect
         2. WEP(Unsupported)                            // Legacy and insecure encryption; not 
recommended
         3. WPA-PSK                                     // Uses shared password; better than WEP 
but outdated
         4. WPA2-PSK                                    // Strong AES-based security with shared 
password
         5. WPA/WPA2-PSK                                // Mixed mode for WPA and WPA2 client 
compatibility
         6. WPA3-SAE (WPA3-Personal)                    // Modern secure authentication; resistant 
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to brute-force
         7. WPA2-PSK+WPA3-SAE (Recommend)               // Mixed mode for WPA2 and WPA3 
compatibility
         8. WPA3-OWE                                    // Encrypted open network without password 
(OWE)
 
 AUTHENTICATION ? [1/3/4/5/6/7/8/Quit] : 4            // Enter 4 to select WPA2-PSK authentication.
 
PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
12345678                            // Enter the password for the AP.
 
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : N  // Enter N to 
skip this step.
                                
============================================
BAND        : 2.4 GHz
SSID        : TEST_AP
CHANNEL     : AUTO(ACS)
Security    : WPA2PSK
ENCRYPTION  : AES(CCMP)
Password    : 12345678
WIFI MODE   : 11b/g/n    (2.4 GHz)
PMF         : Default
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y        // Enter Y to confirm the WIFI 
configuration.
                                 
 
 IP ADDRESS ? [Quit] (Default 10.0.0.1) :            // Enter to select the default IP Address. An 
IP address is a unique identifier assigned to a device so it can communicate on a network.
 
 SUBNET ? [Quit] (Default 255.255.255.0) :               // Enter to select the default Subnet. A 
subnet is a smaller division of a network used to organize and manage IP addresses efficiently.
 
 GATEWAY ? [Quit] (Default 10.0.0.1) :             // Enter to select the default Gateway. A 
gateway is a device that connects a local network to other networks, such as the internet.
============================================
[WLAN1]
IP ADDRESS: 10.0.0.1
SUBNET    : 255.255.255.0
GATEWAY   : 10.0.0.1
============================================
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y            // Enter Y to confirm the IP 
configuration.
 
 DHCP SERVER CONFIGURATION ? [Yes/No/Quit] : Y        // Enter Y to confirm the DHCP Server 
configuration. DHCP automatically assigns IP addresses and network settings to devices on a 
network.
                                 
 
 DHCP SERVER LEASE IP Count(MAX 10) ? [Quit] (Default 10) :
                                // Enter to select the default Lease Count.
 
 DHCP SERVER LEASE TIME(60 ~ 86400 SEC) ? [Quit] (Default 1800) :
                                // Enter to select the default Lease Time.
============================================
[DHCP SERVER]
Start IP  : 10.0.0.2
END IP    : 10.0.0.11
LEASE TIME: 1800
============================================
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 DHCP SERVER CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y    //Enter Y to confirm the configuration.
 
[/RA6W1-RRQ61001] # >>> wpa_supplicant_deinit ...
[wpa_supplicant_deinit_iface] CTRL-EVENT-TERMINATING 
>>> Request Supplicant start 
>>> Renesas RA6W1-RRQ61001 wpa_supplicant 2.10 - Sep/2023
>>> Add SoftAP Inteface (softap1) ...
>>> MAC address (softap1) : 74:90:50:b0:a9:77
[init_net_ifaces]: Switching WiFi mode to: Soft-AP
[init_net_ifaces]: Setting up AP (wlan1)
Stop DHCP Server
 
INFO: DHCP Server is not running.
Start DHCP Server
>>> AP Operating Channel: AUTO
 
>>> DHCP Server Started
 
Soft-AP is Ready (74:90:50:b0:a9:77) 
 

When all settings are completed, the configuration is saved, and the system reboots. Then, the Soft AP mode started 
successfully message appears.
When a station gets connected successfully, AP-STA-CONNECTED with M address of station message is printed.

 AP-STA-CONNECTED fa:87:d8:62:3d:a1
 

A.2 Set up EVK for Station plus Soft AP Mode
To configure the RA6W1 for operating in Station + Soft AP mode:
 1. Open the RA6W1 debug console and run the setup command in the [/RA6W1-RRQ61001Y] prompt.
 2. To complete the setup, complete the following prompts:

[/RA6W1 -RRQ61001] # setup
 
Stop all services for the setting.
 Are you sure ? [Yes/No] : y
 
[RA6W1 -RRQ61001 EASY SETUP – V4]
 
Country Code List:
AD  AE  AF  AI  AL  AM  AN  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  
BL  BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  
CZ  DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  
GH  GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  
JO  JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  
MD  ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  
NP  NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  
RW  SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  
UG  UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ZZ  
 
 COUNTRY CODE ? [Quit] (Default KR, ZZ : for debug) : us
 
SYSMODE(WLAN MODE) ?
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        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
 MODE ?  [1/2/3/4/5/Quit] (Default Station) : 5
BAND ?
        1. 2.4 GHz
        2. 5 GHz
        3. AUTO
 MODE ?  [1/2/3/Quit] (Default 3. AUTO) : 1
[ STATION CONFIGURATION ]
============================================================================
[NO] [SSID]                                         [SIGNAL] [CH] [SECURITY]
----------------------------------------------------------------------------
[ 0] WiFi_Net_2.4G                                      -26   6     WPA2-ENT
[ 1] RenesasMatter                                      -26  10         WPA2
[ 2] REL-GLOBAL                                         -27   6     WPA2-ENT
[ 3] NETGEAR81                                          -36   3         WPA2
[ 4] GGG_AP_2G                                          -36  11         WPA2
----------------------------------------------------------------------------
[Enter] Rescan
============================================================================
 Select SSID ? (1~5/M1~M5/Manual/Quit) : 1
 
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
[123456789|123456789|123456789|123456789|123456789|123456789|1234]
:*********
 
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : n
 
BAND        : 2.4 GHz
SSID        : RenesasMatter
Security    : WAP2PSK
ENCRYPTION  : TKIP/AES(CCMP)
Password    :*********
PMF         : Default
============================================
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 
 IP Connection Type ? [Automatic IP/Static IP/Quit] : a
 
IP Connection Type: Automatic IP
 
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 
 SNTP Client enable ? [Yes/No/Quit] : n
 
[ SOFT-AP CONFIGURATION ]
 
 SSID ? (Default RA6W1 -RRQ61001_B0A977) : TEST_AP             // Enter the SSID name.
 
 
AUTHENTICATION ?
         1. OPEN                                        // No authentication or encryption; any 
device can connect
         2. WEP(Unsupported)                            // Legacy and insecure encryption; not 
recommended
         3. WPA-PSK                                     // Uses shared password; better than WEP 
but outdated
         4. WPA2-PSK                                    // Strong AES-based security with shared 
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password
         5. WPA/WPA2-PSK                                // Mixed mode for WPA and WPA2 client 
compatibility
         6. WPA3-SAE (WPA3-Personal)                    // Modern secure authentication; resistant 
to brute-force
         7. WPA2-PSK+WPA3-SAE (Recommend)               // Mixed mode for WPA2 and WPA3 
compatibility
         8. WPA3-OWE                                    // Encrypted open network without password 
(OWE)
 AUTHENTICATION ? [1/3/4/5/6/7/8/Quit] : 4            // Enter 4 to select WPA2-PSK authentication.
 
 
PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit] 
12345678                            // Enter the password for the AP.
 
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : N
                                // Enter N to skip this step.
============================================
BAND        : 2.4 GHz
SSID        : TEST_AP
Security    : WPA2PSK
ENCRYPTION  : AES(CCMP)
Password    : 12345678
PMF         : Default
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y        // Enter Y to confirm the WIFI
                                 configuration.
 
 IP ADDRESS ? [Quit] (Default 10.0.0.1) :            // Enter to select the default IP Address.
 
 SUBNET ? [Quit] (Default 255.255.255.0) :               // Enter to select the default Subnet.
 
 GATEWAY ? [Quit] (Default 10.0.0.1) :             // Enter to select the default Gateway.
============================================
[WLAN1]
IP ADDRESS: 10.0.0.1
SUBNET    : 255.255.255.0
GATEWAY   : 10.0.0.1
============================================
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y            // Enter Y to confirm the IP 
configuration.
 
 DHCP SERVER CONFIGURATION ? [Yes/No/Quit] : Y        // Enter Y to confirm the DHCP Server 
configuration.
                                 
 
 DHCP SERVER LEASE IP Count(MAX 10) ? [Quit] (Default 10) :
                                // Enter to select the default Lease Count.
 
 DHCP SERVER LEASE TIME(60 ~ 86400 SEC) ? [Quit] (Default 1800) :
                                // Enter to select the default Lease Time.
============================================
[DHCP SERVER]
Start IP  : 10.0.0.2
END IP    : 10.0.0.11
LEASE TIME: 1800
============================================
 
 DHCP SERVER CONFIGURATION CONFIRM ? [Yes/No/Quit] : Y          // Enter Y to confirm the 
configuration.
 
[/RA6W1-RRQ61001] # >>> wpa_supplicant_deinit ...
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[wpa_supplicant_deinit_iface] CTRL-EVENT-TERMINATING 
>>> Request Supplicant start 
>>> Renesas RA6W1-RRQ61001 wpa_supplicant 2.10 - Sep/2023
>>> MAC address (sta0) : 74:90:50:b0:a9:76
>>> Add SoftAP Inteface (softap1) ...
>>> MAC address (softap1) : 74:90:50:b0:a9:77
 
>>> Start STA & SOFT-AP Concurrent mode...
[init_net_ifaces]: Switching WiFi mode to: Station & Soft-AP
[init_net_ifaces]: Setting up Concurrent mode (AP + STA)
Stop DHCP Server
 
INFO: DHCP Server is not running.
Start DHCP Server
>>> AP Operating Channel: 11(2462)
 
Soft-AP is Ready (74:90:50:b0:a9:77)
 
>>> DHCP Server Started
 
Connection COMPLETE to 34:0a:33:78:e5:68
 
>>> Network Interface (wlan0) : UP
         Assigned addr   : 192.168.0.104
             netmask   : 255.255.255.0
               gateway   : 192.168.0.1
         DHCP Server IP  : 192.168.0.1
         Lease Time      : 08h 00m 00s
         Renewal Time    : 04h 00m 00s 
 

When all settings are completed, the configuration is saved, and the "Start STA & SOFT-AP Concurrent mode" 
message appears.

A.3 Set up Station Mode with DPM Enabled
Dynamic Power Management (DPM) is a synthesis of breakthrough in ultra-low-power technologies that enable 
extremely low-power operation of the RA6W1. DPM shuts down all microelements on the chip when not in use, which 
allows a near zero level of power consumption when not actively transmitting or receiving data. DPM also enables 
Ultra-low-power Transmit and Receive modes when the MCU needs to be awake to exchange information with other 
devices. Advanced algorithms enable the device to stay asleep until the exact required moment to wake up to 
Transmit or Receive mode.
For more details about DPM, see PMGR DPM Application Note .
By default, the DPM functionality is enabled upon the device’s connection to an Access Point. This can be 
reconfigured by running the Easy Setup Wi-Fi configuration wizard. DPM allows for considerably reduced power 
consumption by periodically entering various sleep modes when full functionality is not required.
To configure the RA6W1 for operating in Station + DPM mode:
 1. Open theRA6W1 debug console and run the setup command in the [/RA6W1-RRQ61001] prompt.
 2. To complete the setup, complete the following prompts:

[/RA6W1 -RRQ61001/dpm] # setup
 
Stop all services for the setting.
 Are you sure ? [Yes/No] : y
 



RA6W1 Getting Started Guide

R19US0014EK0105   Rev 1.05 Page 75
Apr 28, 2026

 
[ RA6W1 -RRQ61001 EASY SETUP – V4 ]
 
Country Code List:
AD  AE  AF  AI  AL  AM  AN  AR  AS  AT  AU  AW  AZ  BA  BB  BD  BE  BF  BG  BH  
BL  BM  BN  BO  BR  BS  BT  BY  BZ  CA  CF  CH  CI  CL  CN  CO  CR  CU  CX  CY  
CZ  DE  DK  DM  DO  DZ  EC  EE  EG  ES  ET  EU  FI  FM  FR  GA  GB  GD  GE  GF  
GH  GL  GP  GR  GT  GU  GY  HK  HN  HR  HT  HU  ID  IE  IL  IN  IR  IS  IT  JM  
JO  JP  KE  KH  KN  KP  KR  KW  KY  KZ  LB  LC  LI  LK  LS  LT  LU  LV  MA  MC  
MD  ME  MF  MH  MK  MN  MO  MP  MQ  MR  MT  MU  MV  MW  MX  MY  NG  NI  NL  NO  
NP  NZ  OM  PA  PE  PF  PG  PH  PK  PL  PM  PR  PT  PW  PY  QA  RE  RO  RS  RU  
RW  SA  SE  SG  SI  SK  SN  SR  SV  SY  TC  TD  TG  TH  TN  TR  TT  TW  TZ  UA  
UG  UK  US  UY  UZ  VA  VC  VE  VI  VN  VU  WF  WS  YE  YT  ZA  ZW  ZZ  
 
 COUNTRY CODE ? [Quit] (Default KR, ZZ : for debug) : us
 
SYSMODE(WLAN MODE) ?
        1. Station
        2. Soft-AP
        3. WiFi Direct
        4. WiFi Direct P2P GO Fixed
        5. Station & Soft-AP
MODE ?  [1/2/3/Quit] (Default Station) : 1
BAND ?
        1. 2.4 GHz
        2. 5 GHz
        3. AUTO
 BAND ?  [1/2/3/Quit] (Default 3. AUTO) : 1
 
[ STATION CONFIGURATION ]
============================================================================
[NO] [SSID]                                         [SIGNAL] [CH] [SECURITY]
----------------------------------------------------------------------------
[ 0] REL-GLOBAL_2.4G                                    -21   6     WPA2-ENT
[ 1] WiFi_Net_2.4G                                      -22   6     WPA2-ENT
[ 2] REL-GLOBAL                                         -22   6     WPA2-ENT
[ 3] WiFi_Public_2.4G                                   -23   6         WPA2
[ 4] RenesasMatter                                      -27  10         WPA2
----------------------------------------------------------------------------
[Enter] Rescan
============================================================================
 
 Select SSID ? (1~5/M1~M5/Manual/Quit) : 5
 
 PSK-KEY(ASCII characters 8~63 or Hexadecimal characters 64) ? [Quit]
:********
 
 Do you want to set advanced WiFi configuration ? [No/Yes/Quit] (Default No) : n
 
 Enable DPM (Dynamic Power Management) ? [Yes/No/Quit] : y
 
 DPM factors : Defaults ? [Yes/No/Quit] : y
 
============================================
DPM MODE           : Enable
Keep Alive Time    : 30000 ms
User Wakeup Time   : 0 ms
TIM Wakeup Count   : 10 dtim
============================================
 DPM CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
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============================================
BAND        : 2.4 GHz
SSID        : RenesasMatter
Security    : WAP2-PSK
ENCRYPTION  : TKIP/AES(CCMP)
Password    : ********
PMF         : Default
============================================
 WIFI CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 
 IP Connection Type ? [Automatic IP/Static IP/Quit] : a
 
IP Connection Type: Automatic IP
 
 IP CONFIGURATION CONFIRM ? [Yes/No/Quit] : y
 
 SNTP Client enable ? [Yes/No/Quit] : n
 
 
[/RA6W1-RRQ61001/dpm] # 
Connection COMPLETE to 34:0a:33:78:e5:68
 
>>> Network Interface (wlan0) : UP
         Assigned addr   : 192.168.0.104
               netmask   : 255.255.255.0
               gateway   : 192.168.0.1
         DHCP Server IP  : 192.168.0.1
         Lease Time      : 08h 00m 00s
         Renewal Time    : 06h 40m 00s
 
>>> Start DPM Power-Down !!!  
 

When the RA6W1 is in DPM Sleep mode, user input is not accepted by the debug terminal. To re-enable the input, see 
Appendix A.4 Disable DPM Mode.

A.4 Disable DPM Mode
When RA6W1 enters DPM Sleep mode, the debug terminal does not accept the input because the UART interfaces 
are powered down. To exit this state and restart the setup process, complete the following steps:
 1. Copy the string pmgr add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED to the clipboard.

For example, open Notepad, type pmgr add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED, and then copy 
(Ctrl+C) the command string.

 2. To restart the EVK, use the RST_N button.
 3. After restarting, before the message >>> Start DPM Power-Down !!! appears on the console, paste the pmgr 

add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED string in the terminal window, and press Enter.
When this procedure is done successfully, the UART console responds as normal. If DPM mode does not stop 
successfully, try the process again:

Wakeup source is 0x4
 
        ******************************************************
        *              RA6W1-RRQ61001 SDK Information
        * ---------------------------------------------------
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        *
        * - CHIP Name       : RA6W1-RRQ61001 (D3095B)
        * - SKU Type        : 0x20, Dual Band (2.4 + 5 GHz) WI-FI 6
        * - CPU Type        : Cortex-M33 (160MHz)
        * - Kernel Version  : FreeRTOS V11.1.0
        * - SFLASH Type     : 8 MB (Renesas AT25SL)
        * - SDK Version     : V8.0.3.0.4
        * - F/W Version     : RA6W1-RRQ61001-79a76003d0-1
        * - Boot Index      : 0
        *
        ******************************************************
 
 
System Mode : Station Only (0)
Network init...OK
>>> Renesas RA6W1-RRQ61001 wpa_supplicant 2.10 - Sep/2023
>>> MAC address (sta0) : 74:90:50:b0:b5:b6
>>> Start STA mode...
pmgr add_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED                                 //pmgr command 
to disable DPM
 
Connection COMPLETE to 10:7c:61:9a:ca:58
 
[/RA6W1-RRQ61001/pmgr] #         Assigned addr   : 192.168.50.78
               netmask   : 255.255.255.0
               gateway   : 192.168.50.1
         DHCP Server IP  : 192.168.50.1
         Lease Time      : 24h 00m 00s
         Renewal Time    : 20h 00m 00s
 

DPM can be restarted at any time with the pmgr remove_constraint PMGR_CONSTRAINT_SLEEP_PROHIBITED 
command.
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Appendix B AT Command Wi-Fi Provisioning
You can provision the Wi-Fi connection using AT commands through the AT command terminal. For AT command 
interface configuration, see Section Section 4.2.3 Configure RA6W1 EVK AT Command Interface. To provision a Wi-
Fi connection, complete the following steps:
 1. To see nearby apps, enable echo output and then initiate a Wi-Fi scan.

ATE
AT+WFSCAN

 2. Configure the desired Wi-Fi connection with the following command:
 l AT+WFJAP=<SSID>,<Security>,<Encryption>,<Passphrase>

 o <SSID>: AP SSID
 o <Security>: Security protocol.

0 (OPEN), 1 (WEP), 2 (WPA), 3 (WPA2), 4 (WPA+WPA2), 5 (WPA3 OWE), 6 (WPA3 SAE), 7 (WPA2 RSN 
and WPA3 SAE)

 o <Encryption>:
0 (TKIP), 1 (AES), 2 (TKIP+AES)

 o <Key>: Passphrase. 8 ~ 63 characters are allowed

Example:
If selecting Dlink_AP_24G_FZ, the configuration selected should be as follows:
 n <SSID>: Dlink_AP_24G_FZ
 n <Security>: 4 for WPA+WPA2 Security protocol.
 n <Encryption>: 2 for TKIP+AES encryption.
 n <Key>: 12345678 (password of AP).
The example of the command: AT+WFJAP=Dlink_AP_24G_FZ,4,2,12345678
The RA6W1 reboots and connects to the given SSID, with DPM enabled by default.
The procedure is similar for a 5 GHz connection. In this example, the only changes are to <Security> (changed to 
WPA3), and <Encryption> (changed to AES).
AT+WFJAP=R15-5G,6,1,12345678
The additional useful commands for Wi-Fi configuration:

AT+WFSTAT   // for getting the Wi-Fi configuration.
ATF    // for factory reset
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Appendix C Flash Using flash_img_downloader Script
Programming firmware images to the EVK requires the flash downloader. The flash downloader (flash_img_
downloader.zip) is provided with binary images (see Figure 98).

Figure 98. Flash downloader
System requirements:
 n OS (Windows 10 64 bit/Ubuntu 20.04 LTS 64 bit).
 n Python 3.12.x and pycryptodome package.
NOTE  
Install mandatory python library.
pycryptodome

 n For Windows
Open a Windows command prompt and enter the following commands:
python -m pip install pycryptodome

 n For Linux OS
Open a terminal window and enter the following commands:
python -m pip install pycryptodome

Check python version using python –version
Python 3.1.X

To program the firmware image through the UART, you have the following options:
 n For Windows, use flash_img_downloader_uart.bat batch file.
 n For Linux, use flash_img_downloader_uart.sh shell script file.
 n Hardware: RA6W1 EVK, see Figure 99.
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Figure 99. RA6W1 EVK hardware
 n This tool is for both Windows and Linux and the programming can be done automatically.
 n Software: Flash Downloader for UART.
To program the firmware image using Windows:
 1. Execute the batch script in the Windows command prompt.

Usage: flash_img_downloader_uart.bat [img full path]
Example: flash_img_downloader_uart.bat <full_path>/wifi_test_ek_ra6w1_ep.img

Figure 100. Run flash downloader with UART
 2. Enter COM port to use (lowest numbered COM port).

NOTE  
Before running the flash downloader with UART, close any other instances of this COM port to make sure of COM port 
availability.

Figure 101. Enter COM port for UART
 3. If prompted, to start programming the firmware, press the RST_N (Reset) button on the RA6W1 EVK.

Figure 102. Reset RA6W1 EVK
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The script finishes programming the firmware image through UART.

Figure 103. Finished programming a firmware image with UART
 4. After firmware programming is completed, open the Terminal Emulator and configure Tera Term Serial Terminal 

Application for Windows, see Section 4.2.1 Configure Tera Term Serial Terminal Application for Windows. .
 5. Press the Reset button on the EVK.
 6. Check the booting status through UART.

C.1 Program Firmware Images for Windows

Figure 104. Flash boot with downloaded image

C.2 Program Firmware Images for Linux
To program the firmware image using Linux:
 1. Execute the Shell script in the Terminal.

Usage: flash_img_downloader_uart.sh [img full path]
Example: flash_img_downloader_uart.sh <full_path>/wifi_test_ek_ra6w1_ep.img

Figure 105. Run flash downloader with UART
NOTE  
While programming, make sure the port of RA6W1 interface should be /dev/ttyUSB0. Also close any other minicom 
instances of this port to make sure of port availability.

 2. If prompted, to start programming the firmware, press the RST_N (Reset) button on the RA6W1 EVK.
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Figure 106. Reset RA6W1 EVK
The script finishes programming the firmware image through UART.

Figure 107. Finished programming a firmware image with UART
 3. After firmware programming completes, open the Terminal Emulator and configure as in Section 4.2.2 Configure 

Minicom for Linux.
 4. On the EVK, press the Reset button.
 5. Check the booting status through UART.

Figure 108. Flash boot with downloaded image
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Appendix D Python Integration in e2 studio Windows
If Python 3 is already installed and it is not showing in the e2 studio terminal, follow the steps:
 1. In Windows, go to Apps > Advanced app settings > App execution aliases > python3.exe.

Figure 109. Application execution aliases
 2. Create a python3.bat file with the following script.

@echo off
python %*

 3. Copy the python3.bat file to the already existing python3 installation location.
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Figure 110. Python3 Installation folder
 4. Restart e2 studio and check if Python 3 is properly integrated using the below command.

python3 --version
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Appendix E SFlash Memory Maps
This section describes the memory maps for the external SFlash device and how to change the SFlash device 
memory map used in the SDK.
NOTE
The RA6W1 SDK currently supports the following SFlash types:

 n 8-MB SFlash
 n Renesas - AT25SL641
To use a different type of SFlash with the RA6W1, contact Renesas Electronics to confirm compatibility.

The RA6W1 SDK supports 8-MB SFlash.
Table 5. 8-MB SFlash map for RA6W1
Address Name Description Size (kB)
0x0000_0000 Product Header  4

0x0000_1000 Product Header - Backup  4

0x0000_2000 RTOS #0 (64*1024 * 40) 2560

0x0028_2000 Reserved RTOS binary size – Expandable area 508

0x0030_0000 NVRAM NVRAM VEE Segment #1 40

0x0030_A000 NVRAM Backup (Multiplier 8) 280

0x0035_0000 TLS_Cert_Base  704

0x0035_0000 TLS Certificate WPA_Enterprise CA 4 or Unused

0x0035_1000 Cert 4 or Unused

0x0035_2000 Private key 4  or Unused

0x0035_3000 Diffie-Hellmann key 4  or Unused

0x0035_4000 TLS Certificate OTA_Update CA 4 or Unused 

0x0035_5000 Cert 4  or Unused

0x0035_6000 Private key 4 or Unused

0x0035_7000 Diffie-Hellmann key 4 or Unused

0x0035_8000 TLS Certificate HTTPs Client Cert 4 or Unused

0x0035_9000 Private key 4 or Unused

0x0035_A000 Diffie-Hellmann key 4 or Unused

0x0035_B000 CA 4 or Unused

0x0035_C000 TLS Certificate HTTPs Server Cert 4 or Unused

0x0035_D000 Private key 4 or Unused

0x0035_E000 Diffie-Hellmann key 4  or Unused

0x0035_F000 Cert 4 or Unused

0x0036_0000 TLS Certificate MQTTs Client Cert 4  or Unused

0x0036_1000 Private key 4 or Unused

0x0036_2000 Diffie-Hellmann key 4  or Unused

0x0036_3000 CA 4  or Unused

0x0036_4000 TLS Certificate AT-CMD #0 ~ #15 AT command TLS Certificate Key #0 ~ #15 64 or Unused

0x0037_4000 TLS Certificate AWS  20 or Unused

0x0037_9000 TLS Certificate Matter  20 or Unused

0x0037_E000 TLS Certificate MISC1  20 or Unused

0x0038_3000 TLS Certificate MISC2  20 or Unused
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Address Name Description Size (kB)
0x0038_8000 TLS Certificate MISC3  20 or Unused

0x0038_D000 TLS Certificate MISC4  20 or Unused

0x0039_2000 TLS Certificate MISC5  20 or Unused

0x0039_7000 TLS Certificate MISC6  20 or Unused

0x0039_C000 TLS Certificate MISC7  20 or Unused

0x003A_1000 TLS Certificate MISC8  20 or Unused

0x003F_E000 Secure Asset Product Area  4 or Unused

0x0040_0000 RTOS #1 (64*1024 * 40) 2560

0x0068_0000 Reserved RTOS binary size – Expandable area 512

0x0070_0000 User Area #1  1020

0x007F_F000 Partition Table  4
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8.    Revision History
Revision Date Description
1.05 Apr 28, 2026  n Updated e2studio installation steps for 2025-12 version.

 n Updated RFP version to 3.22.
 n Updated SFlash memory maps.

1.04 Mar 26, 2026 Updated the AT Command Jumper Configuration section.

1.03 Nov 28, 2025 Updated Mother-Board to RevE. Updated sections about EVK and its setup, test procedures, 
SDK and build setup. Added appendix about Python integration.

1.02 Aug 31, 2025 Updated sections about programming firmware images, station mode, SDK and bild setup, and 
flash_img_downloader.

1.01 May 30, 2025  n Updated sections about measuring Sleep 1 current consumption and SFlash memory maps.
 n Changed the chip name from RRQ61000 to RA6W1.

1.00 Mar 13, 2025 First release.

Status Definitions
Status Definition
DRAFT The content of this document is under review and subject to formal approval, which may result in modifications or additions. 

APPROVED
or unmarked

The content of this document has been approved for publication. 

RoHS Compliance

Renesas Electronics’ suppliers certify that its products are in compliance with the requirements of Directive 
2011/65/EU of the European Parliament on the restriction of the use of certain hazardous substances in electrical and 
electronic equipment. RoHS certificates from our suppliers are available on request.
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IMPORTANT NOTICE AND DISCLAIMER
RENESAS ELECTRONICS CORPORATION AND ITS SUBSIDIARIES (“RENESAS”) PROVIDES TECHNICAL 
SPECIFICATIONS AND RELIABILITY DATA (INCLUDING DATASHEETS), DESIGN RESOURCES (INCLUDING REFERENCE 
DESIGNS), APPLICATION OR OTHER DESIGN ADVICE, WEB TOOLS, SAFETY INFORMATION, AND OTHER RESOURCES 
“AS IS” AND WITH ALL FAULTS, AND DISCLAIMS ALL WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, WITHOUT 
LIMITATION, ANY IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-
INFRINGEMENT OF THIRD-PARTY INTELLECTUAL PROPERTY RIGHTS.

These resources are intended for developers who are designing with Renesas products. You are solely responsible for (1) selecting 
the appropriate products for your application, (2) designing, validating, and testing your application, and (3) ensuring your 
application meets applicable standards, and any other safety, security, or other requirements. These resources are subject to 
change without notice. Renesas grants you permission to use these resources only to develop an application that uses Renesas 
products. Other reproduction or use of these resources is strictly prohibited. No license is granted to any other Renesas intellectual 
property or to any third-party intellectual property. Renesas disclaims responsibility for, and you will fully indemnify Renesas and its 
representatives against, any claims, damages, costs, losses, or liabilities arising from your use of these resources. Renesas' 
products are provided only subject to Renesas' Terms and Conditions of Sale or other applicable terms agreed to in writing. No use 
of any Renesas resources expands or otherwise alters any applicable warranties or warranty disclaimers for these products.
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